MS Word Intermediate
Designed for Word 2010
Instructor: Bev Alderman

Open Microsoft Word

Formatting Pictures

Crop a Picture

Cropping a picture allows you to remove parts of it. To Crop a Picture, select it.
Click on the Picture Tools Tab in the Ribbon. Click on Crop in the Size group. Drag
the dark black lines along the edges of the picture to remove unwanted parts of
the picture. Click anywhere outside the picture to see your results.
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Crop a Picture to a Shape
Select the picture. Click on the Picture Tools Tab in the Ribbon. In the Size

Group, click on the downward arrow under -
Crop. Select Crop to Shape. Select Heart
shape. Select Cloud shape.
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Note: Not all shapes will work with every picture. Try different shapes until

you find one that works well with your picture.



Compress Picture.

After cropping, you may want to compress your picture to reduce the size of the
picture file, especially if you are planning on sharing it through email or social
media. Select your picture. Click on the Picture Tools Tab. In the Adjust Group,
click on Compress Pictures. Make sure the box that says, delete cropped areas of
pictures is checked.
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Picture Corrections — Adjusting Brightness, Contrast

If your picture isn’t perfect, you can use Word’s Picture Tools Tab to make

corrections to it. Select your picture and click on the Picture Tools Tab. Click on

the downward arrow in the Adjust Group under Corrections and hover over the
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Formatting Pictures

Add a Border to a picture - change color/weight

Adding a border to a picture can enhance its look or draw attention to it. To add a
border, select the picture and click on the Picture Tools Tab. In the Styles group,
click on the downward arrow next to Picture Border. Select the color border that
you want your picture to have. Click on the downward arrow next to the Picture
Border again. Click on Weight to select the border width for your picture.
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Change picture
If you decide you want to change the original picture you selected for your
document, the Change Picture command will allow you to select another
picture to replace it. Select your Picture. In the Picture Tools Tab, in the Adjust
Group, click on Change Picture. Browse to the location of the picture you want
to insert and click on it. Click on Insert in the Dialog Box.
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Picture Effects

Use the Picture Styles Group in your Picture Tools Tab to give your picture some
enhancing effects. Select your picture and in the Picture Tools Tab, Click on the
downward arrow next to Picture Effects and choose Soft Edges. Hover over the
different options to see the effect it has on the picture. Click on your preferred
option.
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Formatting Pictures

Wrap Text

If you are working with text and pictures, the way you wrap text around a picture
and the position of your picture can have a major effect on the look of your
document. Our text is currently set to wrap top and bottom, but let’s take a look
at what happens when we make some changes to that.
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They flap their wings so wide
Angd glide through air like kites
These butterflies are a pretty sight
They're truly amazing and a delight

In pairs and multiples they hover around
They stop and rest where flowers abound
Then hop, and dance, and flutter about
In rhythmic patterns so rapid and sound

Each time I wake up in the beautiful moming
These butterflies greet me by flapping their wings
They brighten my days as I see them floating
In air as they fly they seem to be dancing
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Select the one on the bottom left.

Your picture and text should
look like the example to the
right.

These butterflies are a pretty sxght
They’re truly amazing and a delight

In pairs and multiples they hover around
They stop and rest where flowers abound
Then hop; and dance, and flutter about
In rhythmic patterns so rapid and sound

EachtimeI wake up in the beautiful morning

The} brighten my days as : I see them floating
In air as they fly they seem to be dancing



Remove Background — Select areas to keep — pictures vs. clipart

Removing the background of a picture allows you to delete background in the
image that you don’t want to appear in your picture. Select your picture and in
the Adjust group, click on Remove Background. Word will highlight what it thinks
should be removed in pink. You can change it by clicking on Mark Areas to Keep
or Mark areas to Remove and clicking on the areas you want to keep or remove
in the picture. Clicking anywhere outside the picture will give you your result.
Note: This feature does not work well with clipart pictures.
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Artistic Effects

You can give your picture some creative effects by using the Artistic Effects tool.
To do this, select your picture and in the Picture Tools Tab in the Adjust Group
select Artistic Effects. Hover over the different options to see how they affect
your picture and select the one you like to see the result
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Tabs

Tabs allow you to organize information into columns and rows. They are set in the
Paragraph Group in the Home Tab.

To see how Tabs are set, click on the Dialog Box Launcher of your Paragraph
Group in the Home Tab. Click on Tabs at the bottom of the Dialog Box.
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Click on” Clear All” to clear any tabs (i i L2 o
currently set. In the Tab Stop Position field, ign: Default tab stops:
enter “2” and click on Set. Again, in the Tab 1" s
Stop Position Field, enter “5” and in the Tab stops to be deared:
Alignment section, click on the “Right”
button. Click on Set. Click on Ok. You should
see Tab Indicators in your ruler as below.
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In the example below, we have created a list using our Tabs. Note that text is
aligned left and numbers are aligned to the right because we created one left tab
at 2”and one right tab at 5”.

Construction Remodel 20,000.
Computers 25,000.
Communication 900.
Equipment 15,000.
Insurance 2,500.
Rent 10,000.
Marketing 3,000.
Legal 7,500.



Insert a Table

Tables also allow us to enter text in column and row format and they provide us
with tools that give us flexibility in formatting. To insert a table, place your cursor
in the location you want the table to be and click on the Insert Tab on the Ribbon.
In the Table Group, click on the downward arrow under Table. Highlight 4
columns and 5 rows by hovering over the boxes to highlight them and clicking
when you have selected them.
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Your table should look like the one below with 4 columns and 5 rows.
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Tables cont’d

Entering text into a table is as simple as placing your cursor in the cell where you
want your text to appear, and typing. When you want to advance to the next cell,
simply press your Tab key. Continue entering text and hitting your Tab key until
you are finished. Additional rows will be added as you need them just by hitting
Tab. Your finished Table should look like the one below.

Salesperson Print TV Web
Beth W. $5,550 $13,470 $27,800
Luiz D. $8,547 $17,555 $8,907
Jim M. $10,252 $25,560 $13,745
Mike A. $12,450 $16,925 $11,825
Alice S. $13,578 $6,789 $10,239

When your table is selected you will see a new Contextual Tab in your ribbon
called Table Tools. This Tab allows you to make changes to the Layout and Design
of your table. Click anywhere inside your table to select it.
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Table Tools Layout — Sorting your Table

Sorting information in your Table is possible simply by using the Table Tools Tab

Sort command. Make sure your cursor is located inside your table and click on the
Layout portion of your Table Tools Tab. In the Data group, click on
the Sort icon. This will bring up the Sort dialog box. %l

Sort
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Sorting your Table Cont’d

Select the criteria you would like to sort by, and click on ok. Your table will be
sorted based on the criteria you have chosen. Header row will be selected by
default, indicating that our table has a Header row that should not be included in
the Sort function.

In the example below, we have chosen to sort our table alphabetically by
Salesperson.
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Options... Ok ][ Cancel

Your Table should be sorted like the one below.

Salesperson Print TV Web
Alice S. $13,578 $6,789 $10,239
Beth W. $5,550 $13,470 $27,800
Jim M. $10,252 $25,560 $13,745
Luiz D. $8,547 $17,555 $8,907
Mike A. $12,450 $16,925 $11,825
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Table Tools Layout — Insert a Column or Row

To insert a column in your table, hover over the top of the Print column until you
see a black downward pointing arrow. l Click to highlight the column and in the
Table Tools Layout Tab, in the Rows and Columns group, click on Insert Left. This
will insert a column to the left of the one highlighted allowing you to add
Employee# as a new column heading, and the associated data for each employee.
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To insert a Row, hover to the left of the Jim M. row until you see a slanted arrow.
Click to highlight the row. In the Table Tools Layout Tab, select Insert Above from
the Rows and Columns Group. You will see a new row appear in your Table
allowing you to add Greg M. as a new employee.

Your Table should look like the one below,

Salesperson | Employee # Print TV Web
Alice S. 9438 $13,578 $6,789 $10,239
Beth W. 1181 $5,550 $13,470 $27,800
Greg M. 5484 $7,934 $17,632 $19,287
Jim M. 4563 $10,252 $25,560 $13,745
Luiz D. 7462 $8,547 $17,555 $8,907
Mike A. 6041 $12,450 $16,925 $11,825
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Table Tools Layout — Deleting Columns and Rows

When you want to delete columns or rows of a table, bring your cursor to the top
of a column or to the left of a row until you see your arrow. Click and drag if
necessary, to highlight multiple row(s) or column(s). In your Table Tools Layout
Tab click on the downward arrow under Delete in the Columns and Rows group.
Select Delete Columns or Delete Rows
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In the example below, we have deleted the Jim M. row from our Table.

Salesperson | Employee # Print TV Web
Alice S. 9438 $13,578 $6,789 $10,239
Beth W. 1181 $5,550 $13,470 $27,800
Greg M. 5484 $7,934 $17,632 19,287
Luiz D. 7462 $8,547 $17,555 $8,907
Mike A. 6041 $12,450 $16,925 $11,825
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Table Tools Layout — Total Row

To create a total row in your table, place your cursor in the last cell of your table
and hit the Tab key to create a new row. Type Total in the Left most cell. Select
the cell that you want the total to appear in by hovering at the left border of the
cell until you see a small black diagonal arrow and clicking when it appears. In the

Table Tools Layout Tab click on the Formula Icon fX in the Data group. This will
bring up the Formula dialog box. It will default to =SUM(ABOVE) in the Formula
field. Click on the downward arrow next to the Number Format field and select
your desired number format. Click on OK. Your Table should look like the one

below.
Salesperson Employee # Print TV Web
Alice S. 9438 $13,578 $6,789 $10,239
Beth W. 1181 $5,550 $13,470 $27,800
Greg M. 5484 $7,934 $17,632 19,287
Luiz D. 7462 $8,547 $17,555 $8,907
Mike A. 6041 $12,450 $16,925 $11,825
Total $48,059.00 $72,371.00 $78,058.00
£ Shading -

Table Tools Design — Borders/Gridlines

If you would like to remove the borders from the columns
and rows of your table you can do that. First, highlight the
entire table. Then click on the Table Tools Design Tab. Click
on the downward arrow next to Borders in the Table Styles

group. Click on No Border.

You may also have to click on View Gridlines to turn off
Gridlines if you are still seeing dashed lines bordering your

text and data.

An Example of what your Table should look like when you

have finished is on the next page.
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Below is how your table will look with Borders and Gridlines removed.

Salesperson Employee # Print TV Web
Alice S. 9438 $13,578 $6,789 $10,239
Beth W. 1181 $5,550 $13,470 $27,800
Greg M. 5484 $7,934 $17,632 19,287
Luiz D. 7462 $8,547 $17,555 $8,907
Mike A. 6041 $12,450 $16,925 $11,825
Total $48,059.00 $72,371.00 $78,058.00

Table Tools Design — Table Styles

If you would like to add some color to your table you can easily do that by
selecting your table and clicking on the Table Tools Design Tab. In the Table Styles
group, click on the downward arrow on the right and you will see all the pre-
designed options for changing the look of your table. Hover over them to get a
preview of how your table will look. Click on your preference. Your finished table
should look like the design you’ve chosen, such as the example below.

“ 9438 $13,578 $6,789 $10,239
“ 1181 $5,550 $13,470 $27,800
“ 5484 $7,934 $17,632 19,287
“ 7462 $8,547 $17,555 $8,907
m 6041 $12,450 $16,925 $11,825
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Convert Text to a Table

You can convert text that is organized by columns and rows using tabs, into a
table. Start by highlighting the text.

Salesperson Print v Web

lim M. $10,252 $25,560 $13,745

Beth W. 55,550 513,470 527,800

Luiz 0. 58,547 517,555 58,907

&lice 5. 513,578 56,789 510,239

. . . . Insert Page Layout References

Next, click on your Insert Tab in the ribbon. Click on 5 rﬁ] - E@ lr Zj

the downward arrow under Table and select | |£| Ee 1 =
Tabl Pict Cli 5h SmartA

Convert Text to a Table. or | I T SR Shapes Smand
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You will get a dialog box verifying the organization
of your text. After verifying the information, click
on OK, to convert your text to a Table.
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Insert a Text Box

You may want to insert a text box to draw attention to specific text or to give you
more flexibility with where and how text appears in the document. To insert a
text box, click on the Insert Tab in the Ribbon. In the Text group click on the
downward arrow under Text Box. It will bring up a drop down menu of text box
designs to choose from. Choose the simple text box.
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You should see a text box appear on the current page of your document like the
one below. When your text box is selected, you can resize it, move it to another
location, type text into it, place a picture or shape inside it and more. Highlight
the text inside the text box and press the delete key to delete the text.
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When the text box is selected you will see circles along the sides and at the
corners of it. These are your resize handles. Clicking and dragging these will
increase or decrease the size of your text box. Dragging from the corners will
affect both height and width of the text box. The green filled circle at the top of
the text box will rotate it in one direction or another. Practice resizing and
rotating your text box by dragging these handles.

When your text box is selected you will also notice a new contextual tab in your
Ribbon called the Drawing Tools Tab. This tab allows you to make changes to your
text box such as shape, color, outline and effects.

|E|' [ R |= Intermediate Word Class 2015 - Microsoft Word
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Insert Shapes Shape Styles

Select your text box and click on the Drawing Tools Tab. In the Insert Shapes
group, click on the downward arrow next to Edit Shape. Select the Oval shape.
You should see your text box change to look like the one below.

Click inside your text box and try typing something like this inside. You can
change the font style and size of the text if needed by highlighting it and choosing
your options from the Font Group in the Home Tab of the Ribbon.

Garden Club Meeting
May 26, 2016
Neighborhood Park Gazebo
1:00 p.m.

All Members Welcome
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While your shape is selected, click on the Drawing Tools Tab and click on the
downward arrow next to Shape Fill in the Shape Styles group. Select a color for
your text box. Don’t choose a color that is too dark.

Click on Shape Outline and select an outline for your your text box.

Next, select the Text Box and click on the Insert Tab in the Ribbon. Click on Clipart
in the Illustrations group. This will bring up a Navigation Pane on the right of your
screen. In the search field at the top, type flowers. Select a picture to insert into
your text box. It may have to be resized. Remember to drag from the corners of
the picture to resize both height and width simultaneously.

Select your picture and hover along the perimeter until you see a four arrowed
cross. This is your Move Handle. Use your Move handle to drag the picture within
the text box so that it appears to the side or bottom of your text. Your finished
text box should look similar to the one below.

Garden Club Meeting
May 26, 2016
Neighborhood Park Gazebo
1:00 p.m.

All Members Welcome

G
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Mail Merge Letter

Mail Merge allows you to send a personalized document to a list of recipients. It
inserts name, address, greeting, and other pertinent information into each
individual document as you’ve specified. To start a Mail Merge letter, first type
the content of the letter that will be the same for every recipient.

Below is a sample letter.

March 28, 2017

As you may know, 2010 marks our 10th year of doing business. Over the last
decade, AdWorks has grown from a tiny startup into a robust company with over
200 employees throughout the Southeast. Our growth would not have been
possible without loyal customers like you. Therefore, we would like to extend to
you a 20% discount on your next order. It’s our way of saying “thanks” for your
continued business. We'll keep working hard to provide the best possible
customer service along with innovative products, just as we’ve always done.
Thanks again for choosing AdWorks!

Sincerely,
Liz Doe

President and CEO

We would like to send this letter with a personalized inside address and greeting
for each recipient. We will start by clicking on the Mailings Tab in the Ribbon and
selecting Step by Step Mail Merge Wizard in the drop down menu.
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Mail Merge Cont’d

I

“ Hame Insert Page Layout References Mailings
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This will bring up a navigation pane on the right side of your screen. This pane will

walk us through the process of creating our Mail Merge Letter. Click on Letters as
document type.

Click on Next at the bottom of the Navigation pane to continue.

Mail Merge v X

v [&E

Select document type

What type of document are you
working an?

(@) Letters

() E-mail messages
() Envelopes

(") Labels

() Directory

Letters

Send letters to a group of people.
You can personalize the letter
that each person receives.

Click Mext to continue.
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Click on Use the current document. Click on Next. Click on Type a new list. Click
on Next.

The Dialog box on the left, below, will pop up to allow you to enter the
information for the recipients of your letter. Click on Customize Columns to see
the Dialog box below right. This Dialog box allows you to rearrange the order of
the columns by highlighting the column name and clicking on Move Up or Move
Down. You can also rename the columns if you like by highlighting the column
name and clicking on Rename. A field will appear allowing you to rename the
column to fit your needs. If you would like to add or delete a column you may do
that also by clicking on the Add or Delete Icons. Click on OK.

T T - i T e " .l- ™= I - = B
Tye— - | Costomize Address st e (O e
- e T B
Type recipient information in the table, To add more entries, dick Mew Entry. Eield Names
Title w | First Name: w | Last Name w | Company Name w |Address line1 | Tite I
[ First Name
N Last Mame

ompa

Address Line 1

<> Address Line 2
City v
State
ZIP Code

Country or Region
Home Phone
‘Work Phone

E-mail Address Move Up

4| m | 2

- Mowve Down
[ New Entry ] [ Find... ]
(Castonize Colamrs | x| [ coe [ ok | [ cance |

Once you have customized your columns, enter the first recipient’s information
into the appropriate fields and click on New Entry to add another recipient.
Repeat until you are finished adding recipients to the list and click on OK. You will
be prompted to Name and Save T e i B |
your recipient list. Click on Next — |‘fdd=st ———— e el

. t h N . t . Type redpient information in the table. To add more entries, dick New Entry.
In € aVIga 1on pane’ Title w | First Name | Last Name w | Company Name v|Address Line 1 v|

>

1 1 | 3
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M Customize Columns... OK ][ Cancel
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Place your cursor in the area of your letter, where you want the inside address to
appear. Click on Address block in the Navigation pane. A Dialog box will appear

allowing you to choose how you want the inside address information to appear in
your letter. Choose your preferences and click on OK.

kb [&F)1

Mail Merge

Write your letter

If you have not already done so,

write your letter now.

To add redpient information to
your letter, dick a location in the
document, and then dick one of
the itegpese-ir-

|5 Address black...

=] Greeting line...
j ElecTonic postage...
jﬂ More items...

When you have finished writing
your letter, dick Next. Then you

can preview and personalize each

recipient's letter.

Insert Address Black

Spedfy address elements
Insert recipient's name in this format:

Josh -
Josh Randall Ir. o
Josh Q. Randall Ir.

Joshua

Joshua Q. Randall Jr, =

Insert company name
Inzert postal address:
Never indude the country/region in the address
Always indude the country/fregion in the address
(@ Only indude the country/region if different than:

United States

Format address according to the destination country/region

(2 ]

Preview
Here is a preview from your redipient list:

1 b M

Brian Herner

Palatine Public Library
700 N. Morth Court
Palatine, IL 50067

Correct Problems

If items in your address block are missing or out of order, use
Match Fields to identify the correct address elements from your
mailing list.

Match Fields. ..

Move your cursor to the area where you want your greeting line to appear in your
letter. Click on Greeting line in the Navigation pane and choose how you want
your greeting to appear by clicking on the downward arrows in the dialog box
and choosing your preferences. Click on OK.

-

Insert Greeting Line

2 o)

Greeting line format;

Dear El Mr. Randall

Dear Sir or Madam,

Preview

=] b =]

Greeting line for invalid redpient names:

[=]

Here is a preview from your redpient list:

RE

Dear Barb Royce,

Correct Prablems

If items in your greeting line are missing or out of order, use Match Fields to
identify the carrect address elements from your mailing list.

[ o

I=n
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Next, click on Preview your letters in the Navigation pane. You will see your
letters with the names and associated data of each recipient inserted into them as
you move through the recipient list. You may select recipients to leave out just by
clicking on Exclude this recipient in the Navigation pane. You may also edit
recipients by clicking on Edit recipient list. Clicking on Next at the bottom of the
pane will Complete the Mail merge and allow you to print your letters.

g

.

Mail Merge hd

Preview your letters

One of the merged letters is
previewed here, To preview
another letter, dick one of the
following:

Redpient: 1

427 Find a recpient...

Make changes

You can also change your
redpient list:

7 Edit recipient list...

| Exdude this recipient

When you have finished
previewing your letters, dick
Mext. Then you can print the
merged letters or edit individual

letters to add personal comments.

=
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Track Changes

When you are editing a document, you may want to keep track of the changes
you are making to it, especially if you are collaborating with others. Track
Changes allows you to do that.

Click on the Review Tab in the Ribbon, and click on Track Changes.

From then on, any editing changes you make to your document will be indicated.
The strikethroughs and underlines indicating changes that have been made will be
color coded based on the user who made them.

If you click on the downward arrow under Track Changes, it will bring up a dialog
box showing how different editing changes will be displayed by Word.

Review View

d [ d _d

+ Finak Show Markup v
=] Show Markup -
E Reviewing Pane -

mments Tracking

Try editing the errors in the sample text in your Practice document to see how the
changes are displayed when you are using Track Changes.

To Whom it May Concern:

Thank you for taking the time to meet with va'%h—tme last Thursday aboutthe Sales

‘ Associate position. | enjoyed meeting with you and touring the faceililty. | was very
impressed with the layout of the showroom and competence of the staff atyour
company. | would love the chance to work in such a productive and very supportive
atmosphere.

‘ Aswe talked about, my many years of sales experience, both in commissioned flowor
sales and in the role of Sales Supervisor, would greatly benefit Quality Furnishings. In
that time, | have learned many technigues that would drive sales and drive customer
satisfaction ratings. s+ SualityFossishings.
beantedistetyeuknowthat | have recently received my certificate from the Superior
Sales Training program at the Mational Business Institute. Severaltechnigues covered in
the program are sure to bolster sales. | look forward to having the chance to implement
them at Quality Furnishings.

Thank you again for your consideration in filling this position. Please feelfree to contact

me if you have any guestions orwould like additional information. | am looking forward

to hearing from you soon.

Very truly yours,

Jlohn M. Smith
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Tracking Changes

You can also add Comments instead of changing anything in the document. To
add a comment, highlight the text you want to comment on, and click on the New
Comment icon in the Comments group. A comment balloon will appear in the
right margin allowing you to add your comment.

Mailings Review View Developer
; x* ; 4= ; C ; =2 Ty
_ = B
Mew Delete Previous MNext Track :
Comment = Changes = E
Comments
hhyjﬂjme last Thursday about the Sales /.rf{ﬂ““'““*[”"-“lli

To delete a comment, simply select the comment you’d like to delete and click on
Delete in the Comments group.

You can accept or reject changes by using the Accept/Reject icons in the Changes
group. Click on the downward arrow under Accept to review each change and
accept individually, or accept all changes. Click on the downward arrow under
Reject to review each change and reject individually, or reject all changes.

Accept Reject

Changes

To turn off Tracking Changes, simply click on the Track Changes Icon again.

27



Styles

Styles is a useful tool in Word that can help make your document look very
professional. A Style is a predefined combination of font style, color, and size of
text that can be applied to selected text.

Review View

e e Tt i=E = A s

=7 = T 2l | T AaBbccD AaBbCeD AaBbC AaBbCel aaBbea AADB  Assbced

=EE=EE=EE=E $—v Sy - Mormal T Mo Spaci.. Headingl Heading2  Heading 3 Title Subtitle
Paragraph Pl

On the Home Tab, in the Styles group, you will see the different styles available.
Click on the downward arrow to the right of the group to bring up even more

styles. If you don’t see a style
that suits your needs you can

right click on a style and then AaBbCecD | AaBbCel AaBbCcD AaBbCeD ArB

Update Intense Emphasis to Match Selection 3

click on Modify to change it. Inte
u @)

Select All: (No Data) 1

Fename...

Femove from Quick Style Gallery

Add Gallery to Quick Access Toolbar

s R —.

Properties

MName: ntense Emphasis

Style type: Character
Style based on: BT - The I\/Iodify Style dialog box will
Style for followin 2 -

appear allowing you to change the
elements of the Style to meet the
needs of your document. (You can
also change the name of the
T compirent Style.) Make your desired changes
S e S et samp et and click OK.

Font: Bold, Italic, Font color: Accent 1, Style: Quick Style, Priority: 22
Based on: Default Paragraph Font

Add to Quick Style list
@ Only in this document ) New documents based on this template

OK ][ Cancel ]
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Create a Table of Contents Using Styles

Styles is particularly useful for creating Headings in your document. Using Styles
for Headings allows you to very easily create a Table of Contents for your
document when it is complete. The Headings in our Practice document have been

created using the Heading 2 Style.

Review View

T T . T == A v

== FE 2l T A RaBbccD AsBbCcD AaBHC AaBbCel aaBbca AAQD  AsBbcen

EE == ¢=' - M- Mormal T Mo Spaci.. Headingl Heading2  Heading 3 Title Subtitle
Paragraph

Position your cursor at the beginning of the practice document. Pressing CTRL
Home will take you there quickly. Make sure your cursor is positioned at the top
left margin of the first page of your document and Press CTRL Enter. This will
force a new page. You should now see a blank page. Make sure your cursor is
positioned at the top left margin of this page. Click on the References Tab in the
Ribbon. In the Table of Contents group, click on the downward arrow next to
Table of Contents. Select the Table of Contents design that you want to appear in

your document

Home Insert Page Layout Mailings
T — |

S Add Text ~ [ Insert Endnote w; g
= { Update Table Ag Mext Footnote = — E|
Table of Insert Insert '
Contents = Footnote Citation =~ &
ns
Automatic Table 1
Contenls
L LT T TSPV |
Automatic Table 2
Table of Contents
L LT T e S |
L LT S |

Manual Table
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The Table of Contents will appear in the location you specified. It should look
similar to the one below.

Table of Contents
o B T e B e T T —— i
PTG DN EITREIIID oo eeeeeeemaee e eemcarscassmassasascasssasssasssasssssassassasasesasssasesasssetasetesstesssetssesestesssetsmtiesetetssetsssiemtmetesmtestiamtrettrmtessiamrretas i
LT T TG R L Lo L Lo - 1
=L T T g T L O 2
Format a pichure Using T patire TS A et nne z
L A T F o T z
e~ 4
L g T L 4
L T g B 3
B B - 3
B B T T T T ]
TEH RIS «..cceeeeeessisces s ses s e ssss s s s s e s s mss s e e s s Ee s m e s e e m S e eeaee e eSS e eSS LRSS LS eSS SIS EES S e aees 7
LIsing Shyiesy Craahe On AUNDmGHE TODNE O GOIBRIILS ....oooooooe oo eeeoeeeeeeeeseeeeeseseseeessesseessssaseeesssaeseeesssmseesssseeeessssmeeessssmmeseseesmeeeeeess E
Please fill out our Survey — -1
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